
It ’s a BIG NEWSletter this month! None is bigger than welcoming Microsoft’s very own  
Steve Kraynak into the SumProduct madhouse.  You can find out more about his past and his future below.

Excel Virtually Global gains momentum this month too.  Scheduled for October, our website goes live and you can find out more about this year’s 
Excel, financial modelling, Power BI, Fabric, Copilot and Python event within these very pages.

But good things come in threes for SumProduct – we are also pleased to announce we are a finalist for the Australian Institute of Training and 
Development (AITD) for Excellence in training.  It’s nice to be recognised, unless it’s on Crimestoppers.

Microsoft has been busy too.   Python comes to Excel, the Formula bar gets a facelift, stale values get formatted and we even see spreadsheets in 
space!  That’s on top of all the other new features coming to Excel this month.

There is still room for the usual suspects too.  We’ve another Beat the Boredom Challenge, plus tips on Charts & Dashboards, 
Visual Basics, Power Pivot Principles, Power Query Pointers, Power BI Updates, Examine our A to Z of Keyboard Shortcuts and 
there is even time to LOOKUP this month’s A to Z of Excel functions.  Like buckets, other newsletters just pail in comparison.  
(Enough! – Ed.)

As always, happy reading and remember: stay safe, stay happy, stay healthy.
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Some exciting news to start off with this month!  Dear readers one and 
all, please welcome Steve Kraynak to the SumProduct fold.  Steve joins 
SumProduct after more than a decade as a Product Manager for the 
Excel team at Microsoft, where he directly impacted many features in 
Excel, including new worksheet functions like IFS and TEXTJOIN, Data 
from Picture, Excel for Mac, user experience improvements like Smooth 
Scrolling, and many others.  Prior to this, he was instrumental in leading 
Customer Success at a start-up, Prodiance, who were acquired by 
Microsoft and their tools integrated into Excel.  He brings a passion for 
listening to customers and helping them succeed by making the most of 
technology and their data, especially by using Excel and Power BI. 

Steve is heading up our US team, so if you have any queries on consulting, 
training, financial modelling, model auditing, Power BI etc., please feel 
free to drop Steve a line directly at steve.kraynak@sumproduct.com.   
He will be more than pleased to meet your acquaintance and assist you 
as required.

He also points out he is going to stop me stealing stuff from Microsoft 
websites and sticking it in this newsletter.  Good luck with that Steve! 

SumProduct US and Steve Kraynak
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How did I go from making vaccines to designing features for Excel? 
I always enjoyed working with computers, but never considered tech as a career choice, because I was interested in the life sciences.  After getting a 
degree in biology, I joined a vaccine manufacturer and loved it.  However, I always found myself setting up technology solutions and working on tech 
projects.  This led to an opportunity at a small software company that sold an Excel add-in.  This company, Prodiance, eventually was acquired by the 
Excel team, with me joining as a product manager.  

At Microsoft, my initial focus was on the acquired products, but that soon expanded.  I was able to work on a wide range of areas, including new 
worksheet functions (TEXTJOIN, IFS and some others), the early designs for rich data types, and even some work on SharePoint search (better 
understanding of Excel workbooks).  In recent years, I’ve spent much of my time working to improve Excel for Mac, which has lagged behind Excel for 
Windows.  I’m proud to say that we were able to close that gap significantly, and Excel for Mac now surprises a lot of people.  I was also the product 
manager for an initiative we called “Customer Love”, in which we aimed to improve old features.  This initiative brought improvements such as the 
ability to unhide multiple sheets at one time, resizable conditional formatting dialogs, and “smooth scrolling” in Excel for Windows. 

What’s the biggest surprise I learned at Microsoft? 
They don’t have unlimited resources.  Before I got to Microsoft, I assumed Microsoft had virtually unlimited resources and would surely fix any 
moderately impactful bugs that were found.  A colleague and I found a significant bug in SharePoint that completely blocked what we were trying to 
do.  Microsoft agreed that it was a bug, but it was not a high enough priority for them to fix it.  This was a big surprise to me at the time.  After joining 
the Excel team, I found out that even at the world’s largest software company and for one of the flagship products, resources are limited.  There’s 
so much to work on – endless innovation, a huge amount of maintenance work to keep Excel working on the ever-changing platforms, new security 
threats, etc.  You get the idea.  Even with hundreds of engineers across the globe, they can’t allocate time to everything that would be good to do.  

(That’s me with the blue wig celebrating with some of my Excel teammates after an event on Microsoft’s Redmond campus.) 

My top 5 favourite features in Excel (in random order)

Aside from the fundamentals, like the grid, automatic calculation, charts, number formatting, cell formatting and Tables, here are my top five 
favourite features.  It’s impossible to rank them and my tastes may change, but lately these are my go-to features. 

	 1.	 Power Query: so often, I ask, “have you thought about using Power Query for this?” when discussing a problem with a spreadsheet 	
		  solution.  I think it really lives up to the name “power”

	 2.	 Dynamic Array formulas: Magical! 

	 3.	 Value Preview ToolTips: I’m a little biased about this one, because it was one of the last features I worked on for the Excel team

	 4.	 Slicers: I love that they’re so easy to use and they help guide the user about what they can do with the spreadsheet

	 5.	 PivotTables: simply can’t function without them.  

Why did I join SumProduct? 
As part of the Excel product management team, I met many people from the incredible community of Excel users and professionals around the world, 
including Liam Bastick and Tim Heng, of SumProduct.  The opportunity to work with them and expand SumProduct’s footprint in the US is just not 
going to come around every day, so here I am.  I’m excited to remain a member of the Excel community, but experience what it’s like outside the 
gilded halls of Redmond (mostly concrete actually).  

Welcome aboard, Steve, we look forward to working alongside you too!

Steve in his own words
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At the time of writing, our latest Excel Virtually Global conference 
continues to gain momentum.  It’s looking like we may have c. 40 
presenters this year!  This conference, as always for charity, presents 
many Excel, Data Platform and PowerPoint MVPs, together with other 
acknowledged experts from Microsoft and / or around the globe to 
present, answer questions and demonstrate the future of Excel, Power 
BI, Fabric, ChatGPT, Copilot and possibly Python and how it will make 
your life easier, personally and professionally.

Each session (including Q&A) will last no more than an hour and topics 
will cover all expertise levels, from novice to expert.  Most presenters are 
well known in their spheres, and have written blogs, books and articles 
and / or present video sessions.

Sessions this year will both be live and recorded.  You will be able to 
watch them later with downloads aplenty – there are no medals for 
staying up to watch the entire event live!  That’s just as well, as it will last 
a few days, starting on Tuesday 10 October, 2023.  

From your own favourite chair, bring a laptop, an inquisitive mind and 
your sense of humour.  Be prepared to learn heaps.  And remember, 
it's for charity – this year, there is no ticketing process: all we ask is an 
“honesty box” where you donate to your favourite charity.

For more details (e.g. times, speakers, sessions), please go to www.
excelvirtuallyglobal.com.  The links will go live nearer the time, so keep 
checking back as the program may change too.

Hopefully, we’ll see you there!

The Australian Institute of Training and Development (AITD) Excellence 
Awards recognise outstanding achievement in organisational learning 
and development.  SumProduct has been recognised as a contributor 
to a project which achieved finalist status in the AITD 2023 Awards.  We 
were lucky enough to be achieve finalist status last year, so who knows?  
Maybe this year, we may take our training program a step further.

Projects entered in the AITD Excellence Awards are assessed against 
specific award criteria including business needs, strategic alignment, 

design, delivery and measurable impact by an independent judging panel.  
Entrants must provide evidence to demonstrate a high achievement 
against these criteria to be awarded finalist status.  We are delighted to 
have been nominated and will find out later in the year if we are winners.  
Tim has his tux at the dry cleaners in preparation…

If you would like to find out how our standard or customised 
training programs can benefit you and your team, drop us a line at  
training@sumproduct.com.

Excel Virtually Global 2023

Australian Institute of Training and Development (AITD) Finalist
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This month sees “a significant evolution” in the analytical capabilities 
available within Excel by releasing a Public Preview of Python in Excel.  
Python in Excel makes it possible to natively combine the programming 
language Python and Excel analytics within the same workbook - with no 

setup required.  With Python in Excel, you can type Python directly into a 
cell, the Python calculations run in the Microsoft Cloud, and your results 
are returned to the worksheet, including plots and visualisations.

Python in Excel is rolling out to Public Preview for those in the Microsoft 365 Insiders program, using the Beta Channel in Excel for Windows.

Given there are several languages out there that analysts use (e.g. R, SQL to name but two), it is not unreasonable to consider why is Python the first 
cab off the rank?  There are several reasons mentioned by the Microsoft team.  These are detailed below.

Python in Excel

(Yes, we know it’s a cobra, but it’s a cool picture!)
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Every day, millions of users around the world rely on familiar Excel tools such as formulas, charts and PivotTables to analyse and understand their 
data.  As of this update, Python in Excel will also be natively integrated directly into the Excel grid.  To get started simply use the new PY function 
which allows you to input Python code directly into Excel cells.

For example, to create DataFrames with just a few simple clicks, it’s no more difficult than this:

Excel users now have access to powerful analytics via Python for 
visualisations, cleaning data, machine learning, predictive analytics, 
and more.  Users may now create end to end solutions that seamlessly 
combine Excel and Python all within Excel.  Using Excel’s built-in 
connectors and Power Query, users can easily bring external data into 
Python in Excel workflows.  Python in Excel is compatible with the tools 
users know well, such as formulae, PivotTables and Excel charts.  

An example of an advanced visualisation, for instance, might be the 
following.  You can tap into the potential of well-known Python charting 
libraries like Matplotlib and seaborn to create a wide variety of charts, 
spanning from conventional bar graphs and line plots to specialised 
visualisations such as heatmaps, violin plots and swarm plots.

Built for analysts

mailto:contact@sumproduct.com
http://www.sumproduct.com


contact@sumproduct.com  | www.sumproduct.com  | +61 3 9020 2071 

There is more though.  You can consider the impact of machine learning, 
predictive analytics and forecasting.  For examples, you may leverage 
the capabilities of Python libraries like scikit-learn and statsmodels to 

apply popular machine learning, predictive analytics, and forecasting 
techniques such as regression analysis, time series modelling, etc.  You 
might even throw in a LAMBDA along the way!

You can consider data cleansing too.  You may make efficient use of 
advanced data cleaning techniques such as locating missing values, 

standardising formats, removing duplicates and employing techniques 
like regular expressions for pattern-based transformations.

mailto:contact@sumproduct.com
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Anaconda is a leading enterprise Python repository used by tens of millions of data practitioners worldwide.  Python in Excel leverages Anaconda 
Distribution for Python running in Azure, which includes the most popular Python libraries (e.g. pandas, Matplotlib, scikit-learn), and is securely built, 
tested and supported by Anaconda. Python provided by Anaconda supports a wide array of analytics with Python in Excel.

Python analytics via Anaconda
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Python code used by Excel runs on the Microsoft Cloud with enterprise-
level security as a compliant Microsoft 365 connected experience.  The 
Python code runs in its own hypervisor isolated container using Azure 
Container Instances and secure, source-built packages from Anaconda 
through a secure software supply chain.  Python in Excel keeps your data 

private by preventing the Python code from knowing who you are, and 
opening workbooks from the internet in further isolation within their 
own separate containers.  Data from your workbooks can only be sent 
via the built-in xl() Python function, and the output of the Python code 
can only be returned as the result of the =PY() Excel function.

Users can share Python in Excel workbooks with confidence.  Teammates 
can seamlessly interact with and refresh Python in Excel based analytics 
without needing to worry about installing additional tools, Python 
runtimes or managing libraries and dependencies.  Users may share 
workbooks using collaboration tools such as Microsoft Teams and 

Microsoft Outlook and work together seamlessly via comments, @ 
mentions, and co-authoring with colleagues as they normally would in 
Excel.  Sensitivity labels applied to your workbooks containing Python will 
keep them compliant with your organisation's information protection 
policies too.

Python in Excel is currently available to users running Beta Channel on 
Windows.  This feature will roll out to Excel for Windows first, starting 
with build 16.0.16818.20000, and then to the other platforms at a later 

date.  To use Python in Excel, join the Microsoft 365 Insider Program.  
Then, choose the Beta Channel Insider level to get the latest builds of 
the Excel application.

Runs securely on the Microsoft Cloud, with no setup required

Built for teams

If you’re like us, you probably have a lot of your working life with your 
head immersed in formulae.  These pesky little critters are the backbone 
of any spreadsheet, and they allow you to perform calculations, analyse 
data, build financial models, forecast key variables and create dynamic 

reports.  However, no matter how experienced you (think you) are, 
writing and editing formulae can sometimes be challenging, especially if 
you have complex or nested expressions – which you shouldn’t because 
you should follow the “Rule of Thumb”, viz. 

Formula Bar Reverting to Type
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No formula should be longer than your thumb!

To this end, Microsoft has announced a change that should make your 
formula editing experience easier and more straightforward: the use of 
the Monospaced font in the Formula bar.  The Monospaced font is a type 
of font where each character has the same width, regardless of its shape 
or style.  This means that your formulae will align and space evenly, 

making them easier to read and debug.

Monospaced font, also known as fixed-width or typewriter font, has 
several advantages over a proportional font.  Here are some of the 
benefits of using monospaced font in the Formula bar:

	 •	 Alignment and Readability: Monospaced fonts significantly improve the readability of code by ensuring consistent and clear alignment.  	
	 	 Each character occupies the same amount of space horizontally, which makes it easier to maintain an organised, structured and 		
	 	 consistent layout.  This is particularly helpful for indentation and presenting a clean image

	 •	 Error Detection and Visual Parsing: Monospaced fonts offer consistent alignment, making it easier to quickly spot errors, typos and 	
	 	 discrepancies in code.  This uniform spacing enhances visual parsing of complex structures, aiding in identifying patterns, nested levels 	
	 	 and relationships within the logic.  This is particularly valuable for understanding intricate nested or conditional statements and catching 	
	 	 mistakes early in the authoring process

	 •	 Cross-Platform Consistency: Monospaced fonts offer streamlined copy-pasting of code from different sources while maintaining 	
	 	 formatting.  They also ensure a uniform appearance across various platforms and editors, ensuring consistent readability and structure.

To use the Monospaced font in the Formula bar, simply edit or author a formula in the Formula bar.  You should notice a different rendering of your 
formula text.  Here is an example of a before and after of some formula text:

You can see how by the time we get to the first “m” in the formula, the letters are not consistently centred in 10px width boxes in the “Before” image.

Monospaced Font is currently available to users running Beta Channel on Windows.  This feature will roll out to Excel for Windows first and come to 
the other platforms later.
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Microsoft has just announced a significant improvement to one of 
spreadsheeting's oldest features: Manual calculation mode.  44 years 
ago, Manual calculation mode debuted in VisiCalc in 1979, six [6] years 
before the first release of Excel.  Since its release, the user experience has 
remained largely the same, until now…

Manual calculation mode suspends calculations, which means that the 
values in cells can become out of date.  Microsoft refers to these as being 

stale.  When you edit a cell in a spreadsheet, not all cells become stale, just 
the ones that depend on your change.  Excel tracks stale cells internally.  
Unfortunately, there has been no way to see which cells were pending 
calculation. 

However, with this update, Excel can show these stale cells by striking them 
out.  That way, you know not to rely on them until they are calculated. 

Whilst stale formatting will most often be seen in Manual calculation 
mode, it is not limited to it.  For example, you may get stale cells in 
Automatic calculation mode if you abort a long-running calculation by 
pressing ESC.  Once the calculation resumes and completes, the stale 
formatting will be lifted. 

When a cell containing a stale value is selected, Excel will show a 
warning icon.  If you click on the icon, you will be provided with a menu 
with contextual actions, such as triggering calculation or switching to 
Automatic calculation mode. 

‘Stale Value Formatting’ is an application setting that is on by default.  If you prefer, you can turn it off via the ‘Format Stale Values’ checkbox located 
under the ‘Calculation Options’ menu on the Formulas tab. 

Stale Formatting is currently available to users running Beta Channel on Windows.  This feature will roll out to Excel for Windows first and come to 
the other platforms at a later date.

Stale Value Formatting
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Well, this is something different!

The Excel team must be looking for things to do.  Recently, they collaborated with CCP Games as they developed a new Excel add-in that will 
“supercharge” the EVE Online game experience by making data analytics accessible to all players, with no programming knowledge required.  This 
tool enables players of all skill levels to access and analyse data to optimise gameplay as they strive for galactic domination.  Who needs infrastructure, 
project finance and valuation models anymore..?

EVE Online is a massively multiplayer sci-fi game in which hundreds of 
thousands of players carve out interstellar empires through fleet battles 
and economic warfare.  Set tens of thousands of years in the future, EVE 
is an immersive, community-driven experience featuring a vast player-
run economy and offers professions ranging from commodities trader 
to mercenary, industrial entrepreneur to pirate, mining engineer to fleet 
commander and much more.  From brokering business deals to waging 
war, EVE’s players all have access to a diverse array of tools and interfaces 
to forge their own destiny in New Eden.  EVE Online is renowned for its 
scale, complexity and its gigantic, world record-breaking in-game battles 
where thousands of players come head-to-head in a single star system.

In reality, Microsoft 365’s add-in framework allows developers to create 
custom solutions for Microsoft 365 applications using JavaScript.  In 

Excel, developers can leverage the to create their own custom data types 
containing images, entities, arrays and formatted number values, backed 
by their own custom data sources.  Custom functions are fully supported 
for both inputs and outputs of data types for functions.

EVE Online is the first video game to have developed an Excel add-in using 
this type of data integration.  You may import your data to unlock the full 
potential of Excel's robust analysis and visualisation tools.  You can create 
custom reports, graphs and charts to gain insights into your in-game 
activities, track your progress, and strategise your next steps.  Or you could 
just get a job.  All the information you need for advancement and eventual 
domination will now be at your fingertips. 

You may get started by downloading the Excel add-in.  In an Excel workbook, click on the EVE Online add-in now appearing in the top right.  This will 
open a pane on the right where you select ‘add character’.  Once authorised, you can begin pulling in-game data and using the available functions 
to inform your gameplay.

Now – get back to work!

Spreadsheets in Space!?
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With many of us currently “working from home” / quarantined, there are 
only so Zoom / Teams calls and virtual parties you can make before you 
reach your (data) limit.  Perhaps they should measure data allowance 
in blood pressure millimetres of mercury (mmHg).  To try and keep our 

readers engaged, we will continue to reproduce some of our popular  
Final Friday Fix challenges from yesteryear in this and upcoming 
newsletters.  One suggested solution may be found later in this newsletter.  
Here’s this month’s…

It’s time to chart our progress with ans introductory series into the world of creating charts and dashboards in Excel.  This month, we continue our 
discussion on dashboard design.

In last month’s newsletter, we talked about the five criteria to consider when designing a dashboard, being:

	 1.	 the granularity
	 2.	 level of information required
	 3.	 timescales
	 4.	 leading and lagging metrics
	 5.	 decision making required. 

We also looked at two dashboard examples, one was bad, one was better.  
A good dashboard should be able to answer the frequently asked business 
questions at a glance.  This essentially means that the end user should be 
able to pick out the information they need from the dashboard within a 
few seconds, or at least know where to look for the information they need 
within that time frame.  If the end user is spending minutes scanning for 
that information, there is a problem with the dashboard design.  

Thus, when designing a dashboard, we should endeavour to follow the 
five-second rule.  Five seconds is roughly how much time the end user 
should need to find the information they are looking for when examining 
the dashboard.  Of course, deeper analysis or investigation is expected 
to take longer than five seconds, but the most important metrics should 
stand out to the user.  

For example, we have a sales manager who needs to send the sales performances to the senior management:

	 •	 the income by customer by type and the utilisation
	 •	 the monthly income by customer.

We have a table called Data that contains details of some new items and their suppliers in a clean horizontal structure, as below.  We need to import 
this data into an inventory management system.

However, the system requires a template that only allows one row per item.  Therefore, the data needs to be laid out as follows.

In this challenge, the objective is to use Power Query to transform structure of the data from vertical format to horizontal as shown in the pictures 
above.

As always, there are some requirements:

	 •	 repeated columns are listed in the second table of Question Data.  They have to be in that specific order (i.e. ‘Note’ is the last column of 	
		  every repeated group)

	 •	 all column headers need to be dynamic.  If they are changed, the queries still need to work

	 •	 the number of suppliers for each item may be varied.

Sounds easy?  Try it.  One solution just might be found later in this newsletter – but no reading ahead!  

Beat the Boredom Challenge

Charts and Dashboards
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All of the requested metrics are displayed neatly in one dashboard.  Most 
of the information they requested can be easily found within five seconds.  

The best way to explain this is through a scenario.  

In our example, sales data is categorised into five customer groups, namely 
BizSupplies, Dynamic Attire, Harmonic Sonics, Plumb’n’Stuff and Other 
Clients, and into four types, being Collection, Warehousing, Pick&Pack 
and Distribution.  The sales staff should have a collection of 60-70 well 
maintained and updated charts / chart data that measure various possible 
metrics, operation indicators and business unit indices.  This is akin to 
cockpit reporting, where in an aeroplane, various instruments keep track 
of all key outputs, although some are irrelevant at particular times (e.g.  
de-icer settings are possibly not essential information for landing).  

For each division, each reporting period, they will create a report, probably 
referred to as a dashboard.  This report may contain charts that highlight 
potential issues now or in the future, as well as multitudes of other charts 

that reflect that the business is doing just fine.  When compiling reports for 
the board, be it monthly, quarterly or yearly, the analysts will sift through 
the cockpit reporting data.  They would look for any charts that highlight 
any areas of concern now, or in the near future; ignoring charts that do 
not show any issues.  These charts are compiled and put into a reporting 
dashboard.  

The report(ing dashboard) will then be comprised of, says, six [6] to nine 
[9] charts that will highlight to the board any issues within the company 
that they have to address.  Hence, the analogy to the cockpit dashboard, 
where it is a collection of all the potential charts that an analyst has to 
look over.  The analyst focuses on the charts that raises concern into a 
reporting dashboard for senior management to address.  

At a business level, they key points from each division will be reported.  
This is referred to in different software as the (overall) dashboard.  Data 
may come from many sources and not pertain to one particular product, 
service, business unit or division.

More next month…
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We thought we’d run an elementary series going through the rudiments of Visual Basic for Applications (VBA) as a springboard for newer users.   
This month we go back to basics and look at how to record a macro.

Recording a macro is pretty straightforward and is the typical well users get their feet under the table with VBA.  There are several ways you can do 
this:

	 1.	 From the ‘View’ tab on the Ribbon

	 2.	 From the ‘Developer’ tab on the Ribbon

	 3.	 From the Status Bar

	 4.	 Keyboard shortcut.

Let’s take a brief look at each in turn. 

1. From the ‘View’ tab on the Ribbon

In the ‘View’ tab of the Ribbon, there is a category called ‘Macros’ with a ‘Macros’ button, funnily enough.  Click on the button and a drop-down 
menu will appear.  Select ‘Record Macro…’.

2. From the ‘Developer’ tab on the Ribbon

Similarly, in the ‘Code’ grouping on the ‘Developer’ tab and then select ‘Record Macro’, viz.

3. From the Status Bar

We can find a small button next to the word ‘Ready’ in the status bar at the bottom of Excel

After pressing a “Record Macro” the Record Macro dialog box will appear.  

Visual Basics
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4. Keyboard shortcut

Perhaps not the easiest keyboard shortcut in the world to remember, ALT + W + M + R activates the first method (‘View’ tab on the Ribbon).  It also 
stops the macro recording.  This keyboard shortcut isn’t pretty, but it’s robust.  The ‘Developer’ tab isn’t always on the Ribbon (see last month’s 
newsletter for details) and the status bar has no readily accessible shortcut.

More next month.

Before we get into what the MEDIAN function does, let’s answer the question: what does median mean?  The median is the middle value in a sorted 
list of numbers.  For example, if we have the following set of values: 

6, 1, 2, 9, 3

We have to arrange these values in ascending order: 

1, 2, 3, 6, 9

Then we can then determine that the median is three [3].

If we have an even number of values, e.g.

4, 5, 8, 10

We would take the average of the middle two numbers ((5 + 8) / 2).  Therefore, the median would be 6.5 in this case.

OK, so what does the MEDIAN function do?

The MEDIAN function returns the median value from a column of values in a data table.  The MEDIAN function ignores blanks when calculating the 
median value in a column and returns with a decimal number as a result.  Let’s take a look at an example.  We will create a simple measure using the 
MEDIAN function using the data from this Table: 

Power Pivot Principles
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After adding this table to our Data Model, we can create the following measure: 

=MEDIAN(
	 Median_Example[Data Set]
	 )

Exporting this measure to a PivotTable, we get:
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Power Pivot has automatically arranged our dataset in ascending order and calculated the Median value.  Neat!  This means that the MEDIAN 
function in Power Pivot will not be affected by the way we order the values in our columns and will calculate the median independently.  

Let’s try adding some blank cells into our data set:

Refreshing our PivotTable yields… the same value:

We can see that the MEDIAN function ignores blank cells in our data set, similar to its equivalent function in Excel. 

That’s it for this month; more next time.  
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Each month we’ll reproduce one of our articles on Power Query (Excel 2010 and 2013) / Get & Transform (Office 365, Excel 2016 and 2019) from 
www.sumproduct.com/blog.  If you wish to read more in the meantime, simply check out our Blog section each Wednesday.  This month, we review 
an example where we need to calculate the stock needed from a supplier.

The example for this month’s newsletter combines some Power Query functionality in order to find the solution to a supply problem.  Let’s start by 
looking at the data below, which shows the chairs hired in the last month and the amount that the supplier who maintains the chairs, delivered to 
our fictitious hire company.

The question is: did we have the correct number of chairs supplied?  We know that each set has eight chairs in it, but we can’t tell if we have the 
right number by looking at this data.

Let’s start by creating a query for my order data, by choosing ‘From Table’ in the ‘Get & Transform’ section on the ‘Data’ tab.

We’ll start by to creating a new column in the query which will show all the quantities in chairs: we will use a ‘Custom Column’ for this on the ‘Add 
Column’ tab.

Power Query Pointers
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The M formula used here is

= if [Unit] = "Set" then [Quantity]*8 else [Quantity] 

We now have all our quantities in chairs, but the supplier only deals in 
sets, so we need to know how many sets we need of each type.  We need 
to divide the chair quantity by eight [8] and then round up to the next 
integer.  We could do this in another custom column, but this time we 

will use the options in the ‘Standard’ dropdown on the ‘From Number’ 
section of the menus instead.  We can’t use the ‘Divide (Integer)’ option 
because this will round down, and we need to round up.  Instead, we’ll 
use two steps, starting with ‘Divide’.
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We choose to divide by eight [8].

We then use the ‘Rounding’ dropdown to choose to ‘Round Up’.

We can then rename our new column and remove Division.
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Now we have the quantity in sets, we may group our data.

We need to group by chair type, and for each chair type, we need to sum the number of sets. 

We have the total number of sets for each type, so now we may ‘Close & Load To’ from the ‘Home’ or ‘File’ tab to compare this with the number 
delivered. 
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We specify where we would like the data to appear on our worksheet.

Clearly, we haven’t had enough budget chairs, so we’ve been paying extra as 11 sets must have come from the standard or luxury chairs!  We may 
now alter our future orders to allow for this.

More next time.

New layout switcher

New buttons have been added to make it easy to quickly switch between web and mobile layouts whilst you’re developing your reports.  You’ll find 
the new switcher buttons down at the bottom of the screen, right next to the page navigator.

This month’s updates see a new layout switcher, an update to On-Object Interaction (in Preview), and updates to the ORDERBY function, amongst 
other items and features.  The full list is as follows:

Reporting

	 •	 New layout switcher

	 •	 New bubble range scaling setting

	 •	 On-Object Interaction – updates in Preview:

	 •	 Resizing and positioning to the On-Object menus

	 •	 On-Object format sub-selections now supported in Spotlight 	
	 	 and Focus modes

Modelling

	 •	 Updates to the ORDERBY function

Data connectivity

	 •	 New modern data connectivity and discovery experience in 	
	 	 Dataflows

	 •	 Lakehouses (connector update)

Service

	 •	 XMLA Write support for Direct Lake datasets

	 •	 Automatic replica synchronisation for Dataset Scale-Out 	
	 	 in Preview

Mobile

	 •	 Choose your start-up content

Developers

	 •	 Published AppSource visuals now generate leads in Partner 	
	 	 Center and CRM

Visualisations

	 •	 New visuals in AppSource

	 •	 Drill Down Combo Bar PRO by ZoomCharts

	 •	 Sunburst Chart by Powerviz

	 •	 xViz Performance Flow by Lumel.

Let’s look at each in turn.

Power BI Updates
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New bubble range scaling setting

The new bubble range scaling setting for scatter chart and map visuals 
has now been introduced.  This setting gives report creators more control 
over how the bubble (marker) sizes respond to the data, making it more 
accurate or distinctive based on preference.

With the magnitude option, the bubble areas closely follow the data 
proportions.  With the data-range option, the bubble size limits are 
mapped to data minimum and maximum.  The auto option, which is the 
default setting for new reports, selects the appropriate option based on 
data characteristics. 

This setting may be adjusted in the Formatting panel, Markers -> Shape 
-> Range scaling for Scatter charts or Bubbles >- Size -> Range scaling for 
Maps.  For reports authored in earlier Power BI versions, these settings 
default to (Deprecated) for Scatter charts (which differs in handling 
negative values), and Data range for Map charts.

Azure Maps charts will also include this feature in a coming product 
update.

In the figure above, the size of each country represents ‘Urban Population’, which is also shown on the y-axis.
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On-Object Interaction – updates in Preview

RESIZING AND POSITIONING TO THE ON-OBJECT MENUS

ON-OBJECT FORMAT SUB-SELECTIONS NOW SUPPORTED IN SPOTLIGHT AND FOCUS MODES

The new On-Object Interaction feature was released to Preview back in March.  The improvements keep coming, however, and two are detailed below.

The ability to resize the On-Object menus horizontally has now been added.  This is especially helpful when you’re working with long field names.

When spotlighting a visual or expanding the visual in Focus mode, you can now use On-Object formatting to sub-select and format styles.

The positioning of the On-Object menus has also been improved to make 
better use of the canvas space.  Previously, when a visual was near the 
bottom of the canvas, the On-Object menu was very small and required 

scrolling to be able to see and use the field wells.  Now, the On-Object 
menu moves up and stretches into the canvas to bring the field wells into 
view without needing to scroll.

Before After
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Updates to the ORDERBY function

If there are blanks in the data, you can specify where to order them by adding ‘BLANKS LAST’ or ‘BLANKS FIRST’.  For example, this is a perfectly valid 
expression:

BiggestSpender =

SELECTCOLUMNS (

INDEX (

1,

ALLSELECTED ( 'DimCustomer' ),

ORDERBY ( SUM ( 'FactInternetSales'[SalesAmount] ), DESC BLANKS LAST)

),

'DimCustomer'[FullName]

)

 

Specifying how blanks are handled is optional and can be combined with specifying the order direction (DESC/ASC).  Valid values include:

	 •	 BLANKS DEFAULT.  This is the default value.  The behaviour for numerical values is blank values are ordered between zero and negative  
		  values.  The behaviour for strings is blank values are ordered before all strings, including empty strings

	 •	 BLANKS FIRST.  Blanks are always ordered on the beginning, regardless of ascending or descending sorting order

	 •	 BLANKS LAST.  Blanks are always ordered on the end, regardless of ascending or descending sorting order.

In Focus mode, it can be hard to tell when you’ve entered Format mode with just the subtle border.  To address this, Power BI has added a button 
to the header to better indicate when you’re in Format mode and how to exit Format mode while staying in Focus mode.

New modern data connectivity and discovery experience in Dataflows

The new data connectivity and discovery experience in Dataflow, 
Dataflow Gen2 and Datamart has also been introduced this month.  
Users spend a lot of time finding the right data, the right connection 
information and credentials.  With the new ‘Get Data’ experience, Power 

BI has made it easier to browse different Fabric artifacts through the 
OneLake data hub.  This improved experience aims to expedite this 
process and get you closer to the data that you’re looking for in the 
quickest way possible.

Lakehouses (connector update)

This update includes significant performance improvements to the Lakehouses connector.  They haven’t told us what they are though…
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XMLA Write support for Direct Lake datasets

Automatic replica synchronisation for Dataset Scale-Out in Preview

Published AppSource visuals now generate leads in Partner Center and CRM

Direct Lake datasets now support XMLA-Write operations.  Now you may 
utilise the Business Intelligence (BI) Pro tools and scripts to create and 
manage Direct Lake datasets.

Whether you prefer SQL Server Management Studio (SSMS), Tabular 
Editor, DAX Studio or something else, you can connect to your Direct 
Lake datasets using XMLA endpoints and perform operations such as 

deploying, customising, merging, scripting, debugging and testing.  You 
may use tools like Azure DevOps or GitHub to implement source control, 
versioning and continuous integration for your data models.  You can 
automate and streamline your development and deployment processes.  
You can also use PowerShell or REST APIs to automate tasks such as 
refreshing or applying changes to your Direct Lake datasets. 

The Power BI team has now finalised Dataset Scale-Out configuration 
APIs and completed the replica synchronisation feature.  Specifically, you 
no longer need to enable Scale-Out at the workspace level by using a 
burdensome XMLA request.  The XMLA command is deprecated and will 
no longer work.  You can now enable Scale-Out on a dataset-by-dataset 
basis using the Power BI REST API for datasets.  You also no longer need 

to synchronise read replicas manually if you want to take advantage of 
automatic replica synchronisation.  Automatic replica synchronisation is 
enabled by default.  However, it is also possible to disable automatic 
synchronisation to synchronise the read / write and read replicas of a 
dataset manually for controlled refresh isolation.

Until recently, your customer leads may have come solely from 
customers downloading them from AppSource.com.  However, now you 
have access to even more leads through Power BI, both the Desktop and 
web embed AppSource.

To access these new leads, simply navigate to the Referrals workspace 
in Partner Center (sic).  Here, you can see all the leads you receive from 

Power BI, as well as those from AppSource.com.  Furthermore, if you’ve 
connected your CRM, you’ll see them there too.

By utilising these new leads from Power BI, you can potentially reach 
more customers and increase your business’s growth. 

Choose your start-up content

Power BI mobile application users may now choose which item they 
want to have open automatically whenever they launch the Power BI 
Mobile app.  This feature saves time for users who mostly view a specific 
item on their mobile app, and don’t want to waste time navigating from 
the app’s home page every time they open it.

To configure a launch item for yourself, open the item you want to see 
when you launch the app.  This can be a specific report page, dashboard, 

scorecard, report in an app or an entire app.  When the item is open, 
open the More options (…) menu from the header and select ‘Set as 
launch item’. This will mark the item as the launch item.  Only one item 
at a time may be marked as the launch item.

Administrators may also use Mobile Device Management (MDM) tools 
to remotely configure a launch item for a group of users (front-line 
workers, for example) to simplify their experience with the app.
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New visuals in AppSource

Drill Down Combo Bar PRO by ZoomCharts

The following are new visuals this update:

	 •	 Composed Line Area Bar Chart by Devlup Funnels

	 •	 Galigeo For Power BI

	 •	 Performance Flow – xViz

	 •	 Radial chart by Devlup Funnels

	 •	 Time-lines by BI-Champ.

Drill Down Combo Bar PRO by ZoomCharts offers a wide selection of customisation options, letting creators build everything from regular Bar charts 
to Box and Whisker plots.  This visual also offers cross-chart filtering capabilities combined with on-chart interactions.

The main features include:

	 •	 multiple chart types: choose between Column, Line and Area charts

	 •	 full customisation: customise x and y axes, legend, outline and fill settings

	 •	 stacking and clustering: choose normal, 100% proportional or zero-based stacking

	 •	 static and dynamic thresholds: set up to four [4] thresholds
	 •	 multi-touch device friendly: get the same experience on mouse and touch input devices.

Popular use cases include:

	 •	 Sales and marketing: sales strategies, sales results and campaign-by-campaign marketing metrics

	 •	 Human resources: hiring, overtimes and efficiency ratios by department

	 •	 Accounting and finance: financial performance by region, office or business line

	 •	 Manufacturing: production efficiencies and quality metrics by product line.
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Sunburst Chart by Powerviz

xViz Performance Flow by Lumel

There is a new Sunburst chart by Powerviz, designed to display hierarchical data in a user-friendly and intuitive format.  With its concentric circle 
design, you can easily display part-to-whole relationships and gain valuable insights from your data.

Key features include:

	 •	 customisation: control display style, labels, centre circle, fill patterns and dynamic images

	 •	 colour options: choose from 30+ colour palettes, including colour-blind safe options

	 •	 ranking: easily filter the Top / Bottom N by each level and show the remaining categories as ‘Others’

	 •	 conditional formatting: identify outliers based on value or category rules
	 •	 interactive features: enjoy full interactivity with zoom, drill down and cross-filtering for detailed exploration.

Many other features included annotations, grid view, show condition and accessibility support.

xViz Performance Flow by Lumel is an integrated business flow monitoring visual with an interactive KPI tree visualisation for organisational 
performance management use cases.  It offers insights into people, places, processes and entities with Performance Indicators, trendlines and 
advanced Alerting on goals, metrics and their variances.

Business use cases might include:

	 •	 Sales and marketing: market share analysis and customer segmentation

	 •	 Finance: departmental budgets and expenditure distribution

	 •	 Operations: supply chain management, identify inefficiencies in manufacturing process

	 •	 Education: course structure, curriculum creation

	 •	 Human resources: organisation structure, employee demographics.
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Performance Flow is suitable for a wide range of use cases:

	 •	 organisational performance: discover HR / employee performance insights through an interactive pictorial Organisational Tree chart with 	
		  performance attributes and trends

	 •	 process flow: visualise business flows in various stages using Swim Lanes with connector lines, icons, KPI metrics and trends in one single 	
		  integrated view

	 •	 financial performance: cost centre analysis with Scorecards or KPI Trees
	 •	 sales performance: dive deep into sales performance at regional, departmental and salesperson levels with Decomposition Trees.

The visual is packed with analytical and interactive features such as:

	 •	 interactive hierarchy navigation including quick search, zooming, subtree analysis, etc.
	 •	 streamline processes using Swim Lanes like in Visio

	 •	 uncover hidden / dotted connections using Links

	 •	 data-driven conditional formatting rules

	 •	 custom tabs for end-users.

More next month!

This month sees the release of ‘Insert Pictures into Cells’ and ‘Set Default Theme’ for Windows and Mac Insider users.  Mac Insider users may also 
‘Automatically Crop Pictures’, plus Excel for web users can now ‘Format Individual Data Points in your Charts’.

You can check out the full list here: 

Excel for the web

	 •	 Format Individual Data Points in your Chart via Home Ribbon 	
	 	 Controls

Excel for Windows

	 •	 Share a Section of a Workbook (Current Channel)

	 •	 Copy Values Quickly from the Status Bar (Monthly Enterprise 	
	 	 Channel)

	 •	 Insert Pictures in Cells (Insiders)

	 •	 Default Theme for Office (Insiders)

Excel for Mac

	 •	 Automatically Crop Pictures (Insiders)

	 •	 Insert Pictures in Cells (Insiders)

	 •	 New Default Theme for Office (Insiders)

Android

	 •	 Insert Photos from Android Phone (Insiders)

	 •	 New Default Theme for Office (Insiders)

Enterprise users in the Semi-Annual Channel

	 •	 Various feature updates (see below).

Let’s get started.

New Features for Excel
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Format Individual Data Points in your Chart via Home Ribbon Controls

Share a Section of a Workbook (Current Channel)

Copy Values Quickly from the Status Bar (Monthly Enterprise Channel)

In Excel for the web, you may now format data points in your chart using the Home Ribbon Controls.  With this update, you can choose the fill colour 
for each individual point in the data series.  This can be a helpful way to highlight particular data points and illustrate trends in your data.

In Excel for Windows (Current Channel, and already available in Excel 
for the web), whether collaborating through Teams or on the web, you 
might wish to share information from a workbook.  Of course, you can 
share the entire workbook, but often it’s safer, faster and more efficient 
to share just a section of the workbook for viewing or editing.  You can 

easily share with others a link to a specific sheet, range, table or chart.  
First, you create a link to the shared section of a workbook.  Then, you 
send or make available the link to recipients.  Finally, recipients may 
simultaneously view or edit the workbook section.  

You can now select the value that you want to copy and move it to the 
clipboard.  Then, you can simply paste the information wherever you 
need in your workbook.

Excel has long been able to provide quick facts about your data, such 
as sum, average, maximum and count, on the Status bar when you 
highlight cells.  However, this then begs the question: how do you get 

that information from the status bar back into the workbook? 

Well, as of this update in the Monthly Enterprise Channel for Excel for 
Windows, you may now select the value that you want to copy and move 
it to the clipboard.  Then, you can simply paste the information wherever 
you need in your workbook.
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To do this:

	 •	 open an existing Excel workbook that contains the data to be analysed

	 •	 right-click the Status bar to ensure that values are turned on

	 •	 select the cells that contain the data you want to use, and then review the aggregated information in the Status bar (i.e. average, count, 	
	 	 numerical count, minimum, maximum or sum)

	 •	 select the value in the Status bar to save it temporarily on your clipboard and then click the cell in which you want to.

This feature is available to Office Insiders running Version 2104 (Build 14023.10000) or later on Windows.

Insert Pictures in Cells (Insiders)

In both Excel for Windows and Excel for Mac, Microsoft has now enabled 
the ability for a picture to become the actual cell value.  

Pictures add a splash of colour to your worksheets and provide a visual 
representation of your content.  They also make it easier to understand 
your data and draw insights.  Let’s be honest a picture tells a 1,000-word 
story.

Whilst you have been able to use pictures in Excel for many years, Excel 
has only recently enabled the ability for a picture to become the actual 

cell value.  It remains attached to the data even when the sheet’s layout 
is modified.  You can use it in tables / Tables, sort, filter, and include it 
in formulae too.  

In the last year the Excel team has introduced the new IMAGE function, 
which allows you to place a web picture in cell using a URL.  Now the idea 
is extended.  You now have the ability to insert local pictures, directly 
into cells, from your device or from the stock image libraries. 
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To utilise the feature:

	 •	 select the cell where you want to place the picture

	 •	 select Insert -> Pictures -> Place in Cell, and then select one of the available sources:
			   ○	 This Device

			   ○	 Stock Images

			   ○	 Online Pictures

It should be noted that in order to insert pictures and have them “float” 
on top of your worksheet, like you used to do before, select Insert -> 
Pictures -> Place over Cells instead. 

If you have an existing worksheet that contains a picture that was inserted 
using the ‘Place over Cells’ command, and you want it to become part 

a cell, select the picture and click the ‘Place in Cell’ button that appears 
next to the picture. 

You can also find the ‘Place in Cell’ command in the right-click context 
menu or in the ‘Picture Format’ contextual tab. 

	 	 	 ○	 Animation.
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To directly paste a picture from the clipboard into a cell, select Paste -> 
Paste Picture in Cell on the Home tab or in the right-click context menu.  
Do note though that when you use the default Paste command on the 

Home tab or the context menu, or press CTRL + V to paste a picture, it 
will pasted over cells for now not pasted into the cell. 

mailto:contact@sumproduct.com
http://www.sumproduct.com


contact@sumproduct.com  | www.sumproduct.com  | +61 3 9020 2071 

These capabilities are now available to Insiders running: 

	 •	 Windows: Version 2306 (Build 16529.20000) 

	 •	 Mac: Version 16.75 (Build 23070901).

These capabilities will become available soon in Excel for the web as well as on Excel for iOS and Excel for Android.

Users chose Bierstadt as the preferred font, and so it was adopted and given a new name / identity Aptos.  (Witness protection anyone..?)

This new font supports a variety of weights and includes variants such as narrow, serif and monospace.

	 •	 Bierstadt

	 •	 Grandview

	 •	 Seaford

	 •	 Skeena

	 •	 Tenorite.

(New) Default Theme for Office (Insiders)

In the Insiders channel of both Excel for Windows and Excel for Mac, 
Microsoft has refreshed the Office theme with a new default font, colour 
palette, style, and line weights that help you make your documents more 
modern and accessible.

Microsoft released five [5] Calibri replacement candidate fonts out into 
the wild for feedback.  These were:
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The Excel team also researched popular colour palettes and design trends, and created a set of default colours that works well in all Office apps.  You 
may use these new colours to style content such as charts, lists and shapes. 

The default outline weights have also been increased, improving the consistency between shapes and lines, and adding better contrast.
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But it doesn’t end there (sadly).  Microsoft is also refreshing the default style of its Word documents and Outlook emails to make them apparently 
easier to read, look more professional and easier to navigate.

As the theme rolls out, all new documents, presentations, worksheets and 
emails you create in Word, PowerPoint, Excel and Outlook will use the new 
theme.  That will be nice – especially if you liked the old theme.  Do note, 
however, that your existing documents won’t change.  They will continue 
to use the original theme that was applied when they were created.

If you prefer Calibri and would still like to use the previous Office theme, 
don’t fret.  It’s been renamed Office Theme 2013 – 2022.

If neither Aptos nor Calibri are the right fonts for you, there are hundreds 
of other choices built into Microsoft 365.  Simply choose a typeface that 
matches your needs and set it as your default. 

Even in Word, if you want to revert to the older style formatting, you still 
can.  Simply use Word 2013 formatting from the ‘Document Formatting’ 
menu.

This feature is available to Beta Channel users who are running:

	 •	 Win32: Version 2307 (Build 16626.20076) or later

	 •	 Mac: Version 16.75 (Build 23071400) or later

	 •	 Android: Version 16.0.16626.20076 or later.

It will be coming later to iOS.

Automatically Crop Pictures (Insiders) 

There is another feature now out for Excel for Mac.  If you’ve ever taken a digital picture, you’ve probably used the Crop command.  It’s one of the 
most used features when working with pictures.  Now, with a single click, the ‘Auto Crop’ command helps you identify the most important parts of 
your picture and crops out the rest.

In Excel, Word and PowerPoint for Mac:

	 •	 create or open an existing document, worksheet or presentation

	 •	 to insert a picture, click the Insert tab and select a picture by using one of the available options
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	 •	 select a picture, and then click Picture Format -> Auto Crop.

Notice that your picture is now cropped to focus on its most important parts:

In Excel, Word and PowerPoint for iOS (iPhone and iPad):

	 •	 create or open an existing document, worksheet or presentation, and insert a picture
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	 •	 tap Picture -> Crop -> Auto Crop.

There are known issues for this new feature:

	 •	 it is not yet supported for SVGs or PDFs

	 •	 you may only apply auto crop to one image at a time.

This feature is available to Microsoft 365 Insiders running:

	 •	 iOS: Version 2.76 (Build 23062804) or later

	 •	 Mac: Version 16.76 (Build 23062703) or later.

Notice that your picture is now cropped to focus on its most important parts:

Insert Photos from Android Phone (Insiders)

You may now insert photos from your Android phone into Excel, Word and PowerPoint for Windows files.

In the past, transferring images from your Android phone to an Excel, Word or PowerPoint file required multiple steps.  That’s no longer the case: 
you may now do so by using a wireless connection.
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	 •	 right-click the photo you want, and then select Change Picture -> From Mobile Device.

After you complete these steps, you can transfer your photos from your Android phone.

There are known limitations:

	 •	 you may see a repeated ‘Login’ dialog box when you log in for the first time

	 •	 the ‘Login’ dialog box may take 10 seconds or more to load.

To use this feature:

	 •	 you must have a Microsoft Enterprise account

	 •	 your Android device must be nearby.

This feature is rolling out to Insiders running Version 2307 (Build 16621.10000) or later.

Enterprise users in the Semi-Annual Channel

There are new features and non-security updates that are included 
in Semi-Annual Enterprise Channel updates for Microsoft 365 Apps 
for enterprise, Microsoft 365 Apps for Business, and the subscription 
versions of the desktop apps for Project and Visio.  New or updated, 

features are released in Semi-Annual Enterprise Channel twice a year, on 
the second Tuesday in January and July each year.  It just takes us time 
due to printing deadlines to report them!

It works as follows:

	 •	 open the document, worksheet or presentation in which you want to insert a photo from your Android phone

	 •	 select Insert -> Picture -> Mobile Device 
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The updated version of the grid with all the new features is fast becoming too complicated to show clearly here.  Nonetheless, you can find the 
interactive links at aka.ms/ExcelFeaturesFlyer. 

For Excel, the following feature updates are now available:

	 •	 Touch Improvements to Ribbon: Microsoft has improved the spacing of buttons in the Ribbon when the device is being used in Tablet posture

	 •	 Apply sensitivity labels to PDFs created with Office apps: This update allows you to use these labels to protect PDFs created using Excel,  
		  Word or PowerPoint for Windows

	 •	 Speed-up filtering when workbook contains lots of conditional formatting rules: when your workbook contains lots of conditional  
		  formatting rules, it can slow down applying a filter such as a colour filter.  This is no longer the case.  By optimising the underlying data  
		  structure filtering has been accelerated

	 •	 Improvements to Power BI Request Access: Microsoft has upgraded the experience for users who create PivotTables connected to Power  
		  BI datasets.  Prior to the improved experience, when a user tried to refresh a PivotTable connected to a dataset that they do not have 	
		  access to, they would see a generic error message.  Now, a specific error dialog appears that informs the user that they do not  
		  have access to the dataset and allows them to click a link to request access from the owner.  Once access is granted, the user can go back  
		  to the PivotTable and refresh to continue their analysis

	 •	 PivotTable overlap improvements: the experience has been improved when PivotTables overlap other content in your workbook

	 •	 Smooth Scrolling: scrolling in your sheet is now much smoother.  There is no longer any snapping to rows and columns

	 •	 Reducing unwanted fragmenting of conditional formatting rules: you can check out the improved performance and faster calculations  
		  when applying conditional formatting rules to cells.  This has been achieved by reducing fragmentation of data when pasting copied cells 	
		  into that a cell range

	 •	 Speeding up Formula Entry: Excel has sped up entering a formula in a cell noticeably by reducing memory usage, making more efficient  
		  use of allocated memory and optimising redrawing.  These optimisations are more noticeable on devices with slower Memory or slower  
		  CPU-Memory throughput as well as for larger cell ranges

	 •	 Copy Paste is more efficient:  copy / paste now uses an index-based search, rather than a linear scan, for more optimal merging.  The  
		  optimisations are especially noticeable on low-end devices with constrained hardware

	 •	 New Text and Array Functions: 14 new text and array functions have been added: CHOOSECOLS, CHOOSEROWS, DROP, EXPAND, 	
		  HSTACK, TAKE, TEXTAFTER, TEXTBEFORE, TEXTSPLIT, TOCOL, TOROW, VSTACK, WRAPCOLS and WRAPROWS.
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More next month, we’re sure.

LOOKUP has two forms: an array form and a vector form.  As a reminder:

	 •	 An array is a collection of cells consisting of at least two rows and at least two columns

	 •	 A vector is a collection of cells across just one row (row vector) or down just one column (column vector).

The A to Z of Excel Functions: LOOKUP
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The diagram should be self-explanatory:

The array form of LOOKUP looks in the first row or column of an array for the specified value and returns a value from the same position in the last 
row or column of the same array:

LOOKUP(lookup_value, array)

where:

	 •	 lookup_value is the value that LOOKUP searches for in an array.  The lookup_value argument can be a number, text, a logical value or a  
		  name or reference that refers to a value

	 •	 array is the range of cells that contains text, numbers, or logical values that you want to compare with lookup_value. 

If array covers an area that is wider than it is tall (i.e. it has more columns than rows), LOOKUP searches for the value of lookup_value in the first 
row and returns the result from the last row.  Otherwise, LOOKUP searches for the value of lookup_value in the first column and returns the result 
from the last column instead.

The alternative form is the vector form:

LOOKUP(lookup_value, lookup_vector, [result_vector])

The LOOKUP function vector form syntax has the following arguments:

	 •	 lookup_value is the value that LOOKUP searches for in the first vector

	 •	 lookup_vector is the range that contains only one row or one column

	 •	 result_vector is optional – if ignored, lookup_vector is used – this is the where the result will come from and must contain the same 	
		  number of cells as the lookup_vector.

The lookup_value must be located in a range of strictly ascending values, i.e. where each value is larger than the one before and there are no 
duplicates.

LOOKUP is simple to use, doesn’t rely on row or index column numbers and allows modellers to create inputs that do not need to be specified for all 
periods modelled.  Let me demonstrate with the following example:

Imagine you have an annual model forecasting for many years into the future.  Creating inputs will be time consuming if data has to be entered on a 
period by period basis.  But there is a shortcut.
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Do you see the data table in cells F12:K13 above?  The value in the final cell of the first row is actually “2020” not “2020+”.  It appears that way due 
to custom number formatting (CTRL + 1):

The syntax “0+” adds a plus sign to the number although Excel still reads 
the value as 2020.  

The formula uses the array version of LOOKUP, looking up the year in 
the first row of the data table and returning the corresponding value 
from the final row.  When a year is selected which is greater than 2020, 
the 2020 value is used as LOOKUP seeks out the largest value less than 
or equal to the value sought.  Therefore, we don’t need to have lengthy 

data tables – once we assume inputs will be constant thereafter, we can 
just curtail the input section.

Using the array form of LOOKUP is dangerous though.  What if someone 
accidentally inserts rows?  The lookup will “flip” to look the first and last 
columns instead, which is not what is required. Using the vector form  
is safer:

Whilst the formula contains one more argument, the formula is more 
stable.  Further, the lookup_vector and the result_vector do not need to 
be in the same worksheet or even the same workbook.  In fact, as long as 
there are the same number of elements in each, one can be a row vector 
and the other a column vector.

LOOKUP is very useful when the lookup_vector contains data in strict 
ascending order.  Where do we find this?  Dates in time series – LOOKUP 
is very useful for financial modelling / forecasting.  Just be careful though; 
consider the following scenario:
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Here, the same formula generates an #N/A error.  This is because the date is smaller than the smallest value in the data range.  LOOKUP is not quite 
clever enough to use the first value unprompted, but a simple tweak of the formula will suffice:

Here, the formula has been modified to:

=IF(G$19<$G$12,$G$13,LOOKUP(G$19,$G$12:$K$12,$G$13:$K$13))

The added IF statement checks to see if the year is smaller than the first year in the data table and if so, returns the first result.  Simple.  It is with this 
final modification – in its vector form – that I usually use LOOKUP to return values for certain time periods where I do not want to have an input for 
each period modelled.  Very useful!

This function converts all uppercase letters in a text string to lowercase.

The LOWER function has the following syntax:

LOWER(text)

The LOWER function has the following arguments:

	 •	 text: this is required and represents the text you wish to convert to lowercase.

It should be noted that:

	 •	 LOWER does not change characters in text that are not letters.

The A to Z of Excel Functions: LOWER
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Please see our final example for this month below: 

More Excel Functions next month.

To recap, we had a table called Data that contained details of some new items and their suppliers in a clean horizontal structure, as below.  We 
needed to import this data into an inventory management system.

However, the system required a template that only allowed one row per item.  Therefore, the data needed to be laid out as follows.

In this challenge, the objective was to use Power Query to transform structure of the data from vertical format to horizontal as shown in the pictures 
above.

As always, there were some requirements:

	 •	 repeated columns were listed in the second table of Question Data.  They had to be in that specific order (i.e. ‘Note’ is the last column of  
		  every repeated group)

	 •	 all column headers needed to be dynamic.  If they were changed, the queries still needed to work

	 •	 the number of suppliers for each item may be varied.

Beat the Boredom Suggested Solution

Suggested Solution

Firstly, we should bring two question tables into Power Query, one by one, by selecting each table and then navigating to the Data tab, and click 
‘From Table/Range’ under the ‘Get & Transform Data’ grouping, viz.
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Secondly, we need to convert the ‘Column’ query into a list by going to Transform tab and then selecting ‘Convert to List’.

Thirdly, we come to the Data table.  We rename this query ‘Transformed Table’.

We need Power Query to identify a list of grouped columns (i.e. ItemCode 
and ItemName).  To do this, we add a new step by clicking ‘fx’ next to 
the Formula bar.  Then, the List.RemoveItems and Table.ColumnNames 

functions are used to remove all repeated columns listed in the Column 
list (which we created earlier) from the Source step.  We add the formula 
below to the Formula bar and name this step as GroupCols.

Then, we re-order the columns with the following formula.  List.Combine helps combine grouped columns above with the Column list, which has a 
correct column order for repeated columns.

=Table.ReorderColumns(#“Replaced Value”, List.Combine({GroupCols, Column})

=List.RemoveItems(Table.ColumnNames(Source),Column)
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As you can see from the picture below, Note is now the last column:

We will next remove all the null values in the table by replacing values null with “”.  This ensures that all values are kept after unpivoting later.

After that, we need to unpivot the columns, specifically the four repeated columns in our ‘Column’ list.  We simply select the four columns, right-click 
and select ‘Unpivot Columns’.
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To keep the query dynamic, we need to replace the grouped columns with our variable ‘GroupCols’ from:

= Table.UnpivotOtherColumns(#"Replaced Value", {"ItemCode", "ItemName"}, "Attribute", "Value")

into:

= Table.UnpivotOtherColumns(#"Replaced Value", GroupCols, "Attribute", "Value")

We will next group all repeated columns into their respective ItemCode and ItemName.  To do this, we select both ItemCode and ItemName columns 
and go to the Transform Tab, where we select ‘Group By’.  We name the new column ‘All’ and choose the operation ‘All Rows’ from dropdown list.

Once again, to keep the query dynamic we will replace the values {"ItemCode", "ItemName"} in the formula with GroupCols.
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We are then going to add an index column in each table within the All column, such that when it reaches a row with new ItemCode and ItemName 
values, the index resets to one [1].  We then create a new blank step called Indexed and apply the following formula.

= Table.TransformColumns(#"Grouped Rows", {{"All", each Table.AddIndexColumn(_,"GroupIndex", 1, 1)}})

The above formula indexes the All column and is named GroupIndex, with the index starting at one [1] and increases in increments of one [1].  Next, 
we expand the All column which should then look like the following:

While the above indexing would allow us to separate the data based on each item code and name, we would like to further index and separate the 
data by suppliers as well.  First, we need to establish the number of repeated columns or the number of rows per unique supplier which is four.  To 
do this we use List.Count function as below:

=List.Count(Column)

We will rename this step as RepeatedCols, and next we use the following formula for a new blank step:

= Table.TransformColumns(#"Expanded All", {{"GroupIndex", each Number.RoundUp(_ / RepeatedCols), type number}})

The above formula rounds up the index column to the closest division of four, e.g. 1/4 = 0.25 rounded up is one [1], 2/4 = 0.5 rounded up is still one 
[1] etc.  Thus, the query will now look like this:

mailto:contact@sumproduct.com
http://www.sumproduct.com


contact@sumproduct.com  | www.sumproduct.com  | +61 3 9020 2071 

We next merge the Attribute and GroupIndex columns to give each supplier an index identifier using ‘Merge Columns’ under the Transform tab.   
We name the merged column as Columns.

Then, we select the column Columns and click ‘Pivot Column’ under the Transform tab.  We then choose the column Value as the ‘Values Column’ 
and click ‘Advanced options’ to select ‘Don’t Aggregate’ for the ‘Aggregate Value Function’.

Lastly, we convert “” back to null values using ‘Replace Values’, and finally, ‘Close & Load’.  We should have the end result as follows:

It only takes two minutes if you can type at 500 miles per hour!

Until next month.

 

Location Course Date Date Duration Duration

Online (Australia) Excel Tips and Tricks 11 Sep 2023 09:00-17:00 AEST (-1 day) 23:00-17:00 GMT 1 Day

Online (Australia) Financial Modelling 12 - 13 Sep 2023 09:00-17:00 AEST (-1 day) 23:00-17:00 GMT 2 Days

Online (Australia) Power Pivot, Power Query and Power BI 22 - 24 Nov 2023 09:00-17:00 AEDT (-1 day) 22:00-17:00 GMT 3 Days

Online (Australia) Excel Tips and Tricks 5 Dec 2023 09:00-17:00 AEDT (-1 day) 22:00-17:00 GMT 1 Day

Online (Australia) Financial Modelling 6 - 7 Dec 2023 09:00-17:00 AEDT (-1 day) 22:00-17:00 GMT 2 Days

Upcoming SumProduct Training Courses - COVID-19 update
Due to the COVID-19 pandemic that is currently spreading around 
the globe, we are suspending our in-person courses until further 
notice.  However, to accommodate the new working-from-home 
dynamic, we are switching our public and in-house courses to 
an online delivery stream, presented via Microsoft Teams, with 
a live presenter running through the same course material, 
downloadable workbooks to complete the hands-on exercises 
during the training session, and a recording of the sessions for 

your use within 1 month for you to refer back to in the event 
of technical difficulties.  To assist with the pacing and flow of 
the course, we will also have a moderator who will help answer 
questions during the course.

If you're still not sure how this will work, please contact us at 
training@sumproduct.com and we'll be happy to walk you 
through the process.
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Link to Others
These newsletters are not intended to be 
closely guarded secrets.  Please feel free 
to forward this newsletter to anyone you 
think might be interested in converting to 

“the SumProduct way”.

If you have received a forwarded 
newsletter and would like to receive 
future editions automatically, please 

subscribe by completing our newsletter 
registration process found at the foot of 
any www.sumproduct.com web page.

Any Questions?
If you have any tips, comments or queries 
for future newsletters, we’d be delighted 
to hear from you. Please drop us a line at 

newsletter@sumproduct.com.

Our Services
We have undertaken a vast array of 
assignments over the years, including:
· 	 Business planning
· 	 Building three-way integrated 		
	 financial statement projections
· 	 Independent expert reviews
· 	 Key driver analysis
· 	 Model reviews / audits for internal 	 	
	 and external purposes
· 	 M&A work
· 	 Model scoping
· 	 Power BI, Power Query & Power Pivot
· 	 Project finance
· 	 Real options analysis
· 	 Refinancing / restructuring
· 	 Strategic modelling
· 	 Valuations
· 	 Working capital management
If you require modelling assistance of any 
kind, please do not hesitate to contact us 
at contact@sumproduct.com.

Training
SumProduct offers a wide range of 
training courses, aimed at finance 
professionals and budding Excel experts. 
Courses include Excel Tricks & Tips, 
Financial Modelling 101, Introduction to 
Forecasting and M&A Modelling. 

Drop us a line at training@sumproduct.com 
for a copy of the brochure or download  
it directly from 
www.sumproduct.com/training.

Check out our 
more popular 
courses in 
our training 
brochure:

Key Strokes
Each newsletter, we’d like to introduce you to useful keystrokes you may or may not be aware of.  We’ve started going through the 
alphabet actions.  It’s pretty E-fficient this month…

Keystroke What it does

END Toggle End mode

CTRL + END Selects the last cell in the sheet

CTRL + SHIFT + END Extends the selection to the last cell in the sheet

SHIFT + END Toggle End mode (and extend when you press SHIFT + Arrow key(s))

ENTER Enter value (and move down, depending upon Excel Options)

ALT + ENTER Redo; in Edit (F2) mode: insert line break

CTRL + ENTER Fill value in edited cell into all cells and do not move

CTRL + SHIFT + ENTER Fill value in edited cell into all cells and do not move

SHIFT + ENTER Enter value (and move up, depending upon Excel Options)

ESC Cancel (edit, copy, cut, dialog, etc.)

CTRL + ESC Bring up Start menu (overriding an Excel command)

CTRL + SHIFT + ESC Task Manager (Windows, overriding an Excel command)

SHIFT + ESC Cancel (edit, copy, cut, dialog, etc.)

Execute Enter value (and move down, depending upon Excel Options)

ALT + Execute Redo

CTRL + Execute Fill value in edited cell into all cells and do not move

CTRL + SHIFT + Execute Fill value in edited cell into all cells and do not move

SHIFT + Execute Enter value (and move up, depending upon Excel Options)

There are c.550 keyboard shortcuts in Excel.  For a comprehensive list, please download our Excel file at
www.sumproduct.com/thought/keyboard-shortcuts. Also, check out our new daily Excel Tip of the Day feature on the 
www.sumproduct.com homepage.
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